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2      Intro
Introducing WestCheck
WestCheck is automated citation-checking software that verifies citations extracted from a legal 
document or in a citations list you create manually. You can choose to install WestCheck as an 
integrated application, as a stand-alone application, or both.

• The WestCheck integrated application is integrated with your word-processing program or 
document management system (DMS). You access the application via a word-processing or DMS 
document. 

• The stand-alone application runs in its own interface. When you install WestCheck on a network, 
only the stand-alone application is installed.

Services Available in WestCheck

KEYCITE

KeyCite is the comprehensive, current, and accurate citation research service from West. Direct history 
of a case is added to KeyCite within one to four hours of receipt of the opinion at West. Citing cases are 
added to KeyCite as soon as they are added to Westlaw. History of a statute is added to KeyCite as soon 
as the source documents are added to Westlaw. 

KeyCite provides information such as

• direct appellate history of cases and administrative decisions

• negative citing references for cases and administrative decisions

• citations to cases, administrative decisions, secondary sources, and briefs and other court 
documents on Westlaw that have cited a case, statute, administrative decision, or regulation

• complete integration with the West Key Number System so you can track legal issues discussed in 
a case

• citations to session laws or rules amending or repealing a statute or regulation

• citations to proposed legislation affecting federal or state statutes

KeyCite covers every case in West’s National Reporter System, as well as more than 1 million 
unpublished cases.

KeyCite information is also available for federal statutes and regulations; statutes from all 50 states; 
regulations and administrative decisions from selected states; patents issued by the U.S. Patent and 
Trademark Office; American Law Reports (ALR) annotations; articles from hundreds of law reviews; and 
administrative decisions of selected federal agencies, including the following:

• Board of Contract Appeals

• Bureau of Immigration Appeals

• Comptroller General

• Federal Communications Commission

• Merit Systems Protection Board

• National Labor Relations Board

• Patent and Trademark Office
duction to WestCheck



In addition, KeyCite provides citing references from numerous texts and treatises, including American 
Jurisprudence 2d (Am Jur 2d), Couch on Insurance, Mertens’ Law of Federal Income Taxation, Norton 
Bankruptcy Law and Practice 3d, publications of The Rutter Group, Witkin’s California treatises, and 
Wright and Miller’s Federal Practice and Procedure.

KeyCite Alert automatically monitors the status of cases, statutes, administrative decisions, regulations, 
and law review articles and sends you updates when their KeyCite information changes.

TABLE OF AUTHORITIES

While KeyCite lists cases citing your case, the Table of Authorities service lists the cases cited by your 
case. The Table of Authorities is also available for ALR annotations, law review articles, and selected 
administrative decisions.

The Table of Authorities is a useful tool for finding hidden weaknesses in a case because it shows 
whether the cases on which your case relies have significant negative history. The Table of Authorities 
result allows you to determine at a glance which cited cases merit investigation. 

• Cited cases are marked with KeyCite status flags, which indicate whether the cases have history or 
citing references available in KeyCite.

• Each cited case is marked with depth of treatment stars that indicate the extent to which the citing 
case discusses the cited case.

• Quotation marks indicate when a citing case directly quotes the cited case.

FIND

When you know the citation of the document you want, WestCheck can retrieve the full text of the 
document on Westlaw and send it to a destination you choose. The Find service is available for many 
types of documents, including case law, statutes, regulations, administrative decisions, articles from 
publications such as law reviews and treatises, specialized materials (e.g., OSHA inspection and 
enforcement reports), and materials published in foreign countries.

QUOTERIGHT

Use QuoteRight to verify the accuracy of quotations cited in your document. When WestCheck extracts 
citations from your document, it also creates a list of quotations found in your document. You can 
choose to have the QuoteRight service check these quotations against the full text of the documents as 
they appear on Westlaw.

Pricing Information
WestCheck is billed per transaction. You incur a charge for each document retrieved and delivered by 
West from databases outside your subscription plan. Prices and availability may vary by price plan. Call 
1-800-328-4880 for specific WestCheck charges under your price plan.
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2 Installing WestCheck
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6      Insta
Overview
Information in this chapter will help you install WestCheck. If you have an internal modem or a modem 
that is attached to your computer, you will not have to provide baud rate and other modem settings for 
installation on a local hard drive. WestCheck automatically detects these settings during installation, 
unless you indicate during installation that you want to manually configure your modem settings.

System Requirements

COMPUTER AND OPERATING SYSTEM

To use the WestCheck software, your system must include the following:

• Windows Vista, Windows XP, Windows 2000, Windows 98, or Windows NT 4.0 (Service Pack 4)

• Pentium 90 microprocessor or faster

• At least 11 MB of available hard disk space

• At least 32 MB of available RAM

• 28,800 bps modem recommended or TCP/IP Internet connection

WEB BROWSER

To use the KeyCite Alert service, you must use Internet Explorer 6.0 or later.

COMMUNICATIONS DRIVERS

WestCheck supports and installs the following communications drivers:

Default communications

Internet (http)

West communications

• Internet (TCP/IP)

• Local modem

Note See the install _readme.wri file for more detailed requirements.

SYSTEM DLL VERSIONS

• File mfc42.dll must be version 6.0.8665.0 or later

• File msvcp60.dll must be version 6.0.8972.0 or later

• File msvcrt.dll must be version 6.1.8924.0 or later

REQUIRED FILE SYSTEM RIGHTS

To run WestCheck, the following file rights are required for the folder in which WestCheck is installed:

• Microsoft network-Read, Execute

• Novell network-Read, Filescan (R, F)

• Linux network-(Samba share)-Read, Execute (r-x)
lling WestCheck



To modify or add publications or explanatory phrases, the following file rights are required for the folder 
in which pubs.dat and expphr.dat are installed (the default location is Program Files\West 
Group\Common):

• Microsoft network-Read, Execute, Create/Write

• Novell network-Read, Write, Create, Filescan (R, W, C, F)

• Linux network-(Samba share)-Read, Write, Execute (rwx)

REQUIRED REGISTRY PERMISSIONS

NT 4.0

Full access to the registry on the first launch of wcnet.exe.

Full access to the HKEY_CURRENT_USER registry key when running software.

Read access to HKEY_LOCAL_MACHINE\Software\West Group.

Windows 2000 and Windows XP

Power User rights to own machine for the first launch of wcnet.exe.

Full access to the HKEY_CURRENT_USER registry key when running software.

Read access to HKEY_LOCAL_MACHINE\Software\West Group.

Supported Word-Processing Programs
• Microsoft Word 2007

• Microsoft Word 2003

• Microsoft Word 2002 (XP)

• Microsoft Word 2000

• Microsoft Word 97

• Corel WordPerfect X4

• Corel WordPerfect Office X3, build 13.0.0.392 (Microsoft Vista requires WordPerfect Service Packs 1 
& 2)

• Corel WordPerfect 11, build 11.0.0.305 or later (or Service Pack 1)

• Corel WordPerfect 12, build 12.0.0.499 (or Service Pack 2)

• Corel WordPerfect 10, build 719 or later (or Service Pack 3)

• Corel WordPerfect 9, build 639 or later (or Service Pack 2)

• Corel WordPerfect Law Office 2000

• Corel WordPerfect 8, build 471 or later (or Service Pack 5)

• Corel WordPerfect Suite 8 Legal Edition

Supported Document Management Systems (DMS)
WestCheck supports integration with the following DMS applications:

• iManage infoRite 5.x and DeskSite 6.x
Installing WestCheck      7
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• DOCS Open 3.5x, 3.7x, 3.8x, and 3.9x

• PC DOCS 3.9x

Installing WestCheck on a Local Hard Drive
You can download WestCheck from the WestCheck software download site at
http://west.thomson.com/software/westcheck/default.aspx.

1. Follow the on-screen installation instructions until the Welcome dialog box is displayed (see 
Figure 2-1).

Figure 2-1. Welcome dialog box

2. Click Next in the Welcome dialog box.

The Software License Agreement dialog box is displayed (see Figure 2-2).

Figure 2-2. Software License Agreement dialog box

3. After reading the agreement and agreeing to its terms, click Yes.

The Select Setup Type dialog box is displayed (see Figure 2-3 on page 9).

Click Next.

After reading the license 
agreement, click Yes.
alling WestCheck
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Figure 2-3. Select Setup Type dialog box

4. Click the Typical icon to install both the WestCheck integrated application and the WestCheck 
stand-alone application. Click the Custom icon to install either the WestCheck integrated 
application or the WestCheck stand-alone application.

• If you select the typical installation, the Choose Destination Location dialog box is displayed (see 
Figure 2-5 on page 10). The dialog box displays the software you chose to install and the default 
installation folder.

• If you select the custom installation, the Select Components dialog box is displayed, as shown 
below in Figure 2-4. By default, all components are selected. If you have Microsoft Word installed 
on your computer, WestCheck for Microsoft Word and WestCheck Application (stand-alone 
version) are selected. If you have Corel WordPerfect installed on your computer, WestCheck for 
Corel WordPerfect and WestCheck Application (stand-alone version) are selected. Clear the check 
box next to the component you do not want to install, then click Next. The Choose Destination 
Location dialog box is displayed (see Figure 2-5 on page 10). The dialog box displays the software 
you chose to install and the default installation folder.

Figure 2-4. Select Components dialog box

Click the Typical icon to install both the 
integrated and the stand-alone 
applications.

Click the Custom icon to select either the 
integrated or the stand-alone 
application.

Click Network to install WestCheck on a 
network. For more information, see 
”Installing WestCheck on a Network” on 
page 12.

Clear the check box before 
the component you do not 
want to install, then click 
Next.
Installing WestCheck      9



10      Ins
Figure 2-5. Choose Destination Location dialog box

5. To install to the default destination folder, click Next.

Or, to install to a different destination folder, click Browse. From the Choose Folder dialog box that 
is displayed (see Figure 2-6) double-click the folder where you would like WestCheck installed. The 
path will automatically be entered in the Path text box. Click OK when finished, then click Next in 
the Choose Destination Location dialog box to continue.

Figure 2-6. Choose Folder dialog box

6. An Upgrade dialog box may be displayed if you have other versions of WestCheck installed on your 
computer. Click Yes to upgrade the older version of WestCheck that was detected.

The Start Copying Files dialog box is displayed (see Figure 2-7 on page 11).

7. Click Next to continue.

A Communication Setup dialog box is displayed, asking if you would like to configure West 
Communication (to Westlaw) now.

8. Click Yes to configure communications.

A second Communication Setup dialog box is displayed (see Figure 2-8 on page 11).

To install to the default 
destination folder, click Next.

To install to a different 
destination folder, click Browse.

Double-click 
the folder 
where you 
would like 
WestCheck 
installed, then 
click OK.
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Figure 2-7. Start Copying Files dialog box

Figure 2-8. Communication Setup dialog box

9. Click Next to continue. Communication Setup will detect the communications device your 
computer will use to access Westlaw.

A third Communication Setup dialog box is displayed showing the communications device 
detected (see Figure 2-9).

Figure 2-9. Communication Setup dialog box

Click Next.

Click Next to allow Communication Setup to 
detect the communications device your 
computer will use to access Westlaw.

If Communication Setup detected the 
correct communications device, click Next.

If Communication Setup did not detect the 
correct communications device, click Change 
to select the correct device.
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10. If the communications device is correct, click Next. If the communications device is not correct, click 
Change to change the communications device.

A fourth Communication Setup dialog box is displayed similar to the one shown in Figure 2-10.

Figure 2-10. Communication Setup dialog box

11. Complete or verify the information for your communications device, then click Next to continue.

A fifth Communication Setup dialog box is displayed telling you that your communications device 
was set up successfully.

12. Click Finish.

The Setup Complete dialog box is displayed. The dialog box will vary, depending on the operating 
system you are using.

13. If you need to reboot your computer, the Setup Complete dialog box is displayed. Click Yes, I want 
to restart my computer now to reboot your computer. You must do this before running WestCheck. 
Click No, I will restart my computer later if you are going to reboot your computer later and not 
run WestCheck at this time. Click Finish.

Installing WestCheck on a Network
The WestCheck stand-alone application is available for network installation.

You can download WestCheck from the software download site at http://west.thomson.com/
software/westcheck/default.aspx.

To install the WestCheck stand-alone application on a network, complete the following steps:

1. Follow the onscreen installation instructions until the Welcome dialog box is displayed (see 
Figure 2-1 on page 8).

2. Click Next in the Welcome dialog box.

The Software License Agreement dialog box is displayed (see Figure 2-2 on page 8).

3. After reading the agreement and agreeing to its terms, click Yes.

The Select Setup Type dialog box is displayed, (see Figure 2-11 on page 13).

Complete or verify the 
information, then click Next.
talling WestCheck
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Figure 2-11. Select Setup Type dialog box

4. Click the Network icon to install the WestCheck stand-alone application on a network.

The Choose Destination Location dialog box is displayed (see Figure 2-5 on page 10). The dialog 
box displays the software you chose to install and the default destination folder.

5. To install to the default destination folder, click Next.

Or, to install to a different destination folder, click Browse. From the Choose Folder dialog box that 
is displayed (see Figure 2-6 on page 10) double-click the folder where you would like WestCheck 
installed. The path will automatically be entered in the Path text box. Click OK when finished, then 
click Next in the Choose Destination Location dialog box to continue.

The Start Copying Files dialog box is displayed.

6. Click Next to continue.

The System Administrator dialog box is displayed asking if you want to customize WestCheck.

7. Click Yes to customize WestCheck. This enables system administrators to configure WestCheck, 
including restricting the areas of WestCheck their users can change, and set up communications 
and client validation.

The WestCheck System Administrator dialog box is displayed (see Figure 2-12).

Figure 2-12. WestCheck System Administrator dialog box showing the General tab

Click the Network icon to install the
stand-alone application on a network.

Select the items you want to 
give users access to.

Select the report items you 
want users to be able to 
change.

Select the default settings.

Select the Citation check 
box if you want report results 
arranged by citation.
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8. On the General tab of the WestCheck System Administrator dialog box, system administrators can 
select the areas to which their users will have access. In the Allow User To section, select the check 
boxes next to the options you want your users to have access to (e.g., select the Modify 
Publications check box if you want your users to be able to modify the Publications list).

In the Report section, select the User Can Change check boxes next to the report options that you 
want your users to have access to (e.g., select the Print KeyCite Case Status Flags check box if you 
want your users to be able to print KeyCite status flags). Select the Default Setting check boxes 
next to options that you want as default settings for the application. Select the Citation check box 
if you want report results arranged by citation. (If you do not select the Citation check box, report 
results are arranged by services, e.g., KeyCite, Table of Authorities.)

9. Click the Communications tab to configure the communications to Westlaw for your firm (see 
Figure 2-13).

Figure 2-13. WestCheck System Administrator dialog box showing the Communications tab

Verify that Internet is selected below Connect Via to connect to Westlaw via an Internet connection.

Type the Internet address of the proxy server or West router in the Internet Proxy text box. This 
information enables the software to connect through a firewall.

Type the Term ID value in the Term ID text box. The Term ID is a specific setting for Westlaw access 
that can be supplied only by West Customer Technical Support at 1-800-WESTLAW (1-800-937-
8529).

Note The WestCheck network installation does not support using West communications for 
connecting to Westlaw. If it is necessary to use West communications for a dial-up 
connection to Westlaw or route through a firewall or proxy server, you will need to install 
WestCheck locally.

10. Click the Client Validation tab to set up either a West-supplied or a custom client validation 
program (see Figure 2-15 on page 15). If you do not want to set up client validation, select None on 
the Client Validation tab, under Validation Type.

Verify that Internet is selected to 
connect to Westlaw via an 
Internet connection.

Type the Term ID.

Type the Internet address of the proxy server.
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To set up a West-supplied client validation program, complete the following steps:

• Before setting up client validation, you must first create the data or text file using a text file 
editor that saves the file in ASCII format, such as Windows Notepad. You can also create the file 
in a word processor if you save the file in ASCII format. The data file is simply a list of valid client 
identifiers, each followed by a carriage return. A sample data file created in Notepad is shown in 
Figure 2-14 below. Save the file as Read Only to the folder on the network where WestCheck is 
being installed (e.g., Q:\apps\WestCheck\Client.dat). To view details or make modifications to 
your Client Validation program, use the Client Validation tab in the WestCheck System 
Administrator dialog box (see Figure 2-15).

Figure 2-14. Sample client data file

• Select West under Validation Type (see Figure 2-15).

• Type the network path and file name of the data file that was created in step a. above
(e.g., Q:\apps\WestCheck\Client.dat) in the Data File text box.

• Type the format of the client identifiers your firm or company uses to access Westlaw in the 
Format Value text box.

• Type the numeric position at which you want the client validation program to start checking 
client IDs in the Start text box. 

• Type the number of client ID characters you want to be validated in the Length text box.

Figure 2-15. WestCheck System Administrator dialog box showing the Client Validation tab, West-supplied client validation option

Select West.

Type the network path and file 
name of the data file.

Type the format in which you want 
users to enter their client ID.

Type the number of client ID 
characters you want to be validated.

Type the numeric position at which you want client 
validation to start checking client IDs.
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Note The sum of the numbers you type in the Start text box and the Length text box must be less 
than or equal to 32.

To set up a custom client validation program, complete the following steps:

• Select Custom under Validation Type (see Figure 2-16).

• Type the complete path of the location of your custom client validation program in the Program 
Location text box.

Figure 2-16. WestCheck System Administrator dialog box showing the Client Validation tab with custom client validation option

11. Click OK when you have finished entering your information in the WestCheck System Administrator 
dialog box.

A Communication Setup dialog box is displayed, asking if you would like to configure West 
communications (to Westlaw) now.

12. Click Yes to configure communications.

A second Communication Setup dialog box is displayed (see Figure 2-17).

Figure 2-17. Communication Setup dialog box

13. Communication Setup will detect the communications device your computer will use to access 
Westlaw. Click Next to continue.

Select Custom.

Enter the complete path of the location of 
your custom client validation program.

Click Next to allow Communication Setup 
to detect the communications device your 
computer will use to access Westlaw.
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A third Communication Setup dialog box is displayed showing the communications device 
detected (see Figure 2-18).

Figure 2-18. Communication Setup dialog box

14. If the communications device is correct, click Next. If the communications device is not correct, click 
Change to change the communications device.

A fourth Communication Setup dialog box is displayed similar to the one shown in Figure 2-10 on 
page 12.

15. Complete or verify the information for your communications device, then click Next to continue.

A fifth Communication Setup dialog box is displayed telling you that your communications device 
was set up successfully.

16. Click Finish.

The Setup Complete dialog box is displayed telling you that the installation is complete.

17. Click Finish.

18. Next, you need to create a shortcut to WestCheck and distribute it to your users’ desktops. The 
shortcut must be linked to the executable file wcnet.exe on the server where you installed 
WestCheck.

The first time WestCheck is accessed from a user’s desktop, wcnet.exe verifies that the user’s 
system files are current. If they are not current, wcnet.exe will update them. Once wcnet.exe has 
verified that the user’s files are up-to-date, the shortcut link will change from wcnet.exe to 
winwc451.exe.

To assist you with the distribution of the WestCheck shortcut, a sample batch file (wc.bat) is 
provided in the WestCheck folder. Use this file as a reference or modify it as needed to link it to the 
location where WestCheck is installed on your network.

Note If you use a systems management suite (e.g., Microsoft SMS, Novell ZenWorks, Intel LanDesk), 
you can distribute the batch file (wc.bat) to your users to run. Refer to the install_readme.wri file 
for further details pertaining to network installation.

If Communication Setup did not detect 
the correct device, click Change to 
select the correct device.

If Communication Setup detected the 
correct communications device, click Next.
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WestCheck Basic Steps
You can use the following steps as a basic outline for conducting your WestCheck research:

1. Create a citations list.

You can create a citations list by extracting citations from a document or by manually typing a 
citations list.

2. Verify your citations list.

You can automatically verify your citations list to eliminate any invalid citations from your list 
before running it in KeyCite or the document services on Westlaw.

3. Run WestCheck to obtain results from Westlaw.

Run the verified citations list on Westlaw to retrieve results from the KeyCite, Table of Authorities, 
Find, and QuoteRight services.

4. View your result.

After running your citations list on Westlaw, you can use these Westlaw capabilities:

• Download your result.

• Print your result on an attached or Westlaw printer.

• Send your result to an e-mail address.

• Send your result to a fax machine.

• Save your result to your document management system.

Starting WestCheck

STARTING THE INTEGRATED APPLICATION

To start the WestCheck integrated application, open the document you want to check in your word-
processing program.

STARTING THE STAND-ALONE APPLICATION

To start the WestCheck stand-alone application, choose Programs, West Applications, WestCheck 
4.58 from the Start menu or double-click the WestCheck icon on your desktop.

The Welcome dialog box is displayed (see Figure 3-2 on page 22).

Creating and Editing Your Citations List

CREATING YOUR CITATIONS LIST BY EXTRACTING CITATIONS FROM A DOCUMENT

In the Integrated Application

Complete the following steps to create a citations list by extracting citations from a displayed 
document:

1. Click the WestCheck button  on the toolbar or choose WestCheck, Citations List from the Tools 
menu. In Word 2007, click the Add-Ins tab on the toolbar, click WestCheck on the Ribbon, and 
choose Citations List.
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Note to Corel WordPerfect users: Click the WestCheck button  on the Legal toolbar. To view 
the Legal toolbar, choose Toolbars from the View menu, select the Legal check box, and then click 
OK.

2. WestCheck extracts the citations from your document. The extracted citations are displayed in the 
WestCheck 4.5 dialog box (see Figure 3-1).

Figure 3-1. WestCheck 4.5 dialog box in the integrated application

Note With WestCheck version 4.53 and later, you cannot save citations lists. Each time you extract 
citations, WestCheck builds a new citations list from your document.

In the Stand-Alone Application

Complete the following steps to create a citations list by extracting citations from a document:

1. At the Welcome dialog box (see Figure 3-2 on page 22), select Extract a citations list from a 
document, then click OK.

An Open dialog box is displayed.

2. Select the document from which you want to extract citations, then click Open.

WestCheck extracts the citations from your document. The extracted citations are displayed in the 
WestCheck 4.5 dialog box (see Figure 3-1. ).

CREATING A NEW CITATIONS LIST IN THE STAND-ALONE APPLICATION

You can build a new citations list by typing the citations. Complete the following steps to create a 
citations list:

1. At the Welcome dialog box (see Figure 3-2 on page 22), select Create a new citations list, then 
click OK. If WestCheck is currently running, choose Create a new citations list from the File menu.

The WestCheck 4.5 dialog box is displayed (see Figure 3-3 on page 22).
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Figure 3-2. Welcome dialog box in the stand-alone application

2. To add a citation, double-click Double click here to add a citation and then press Enter.

3. Type the citation and press Enter.

4. Repeat step 3 for each citation you want to add.

5. Verify your citations. For more information, see ”Verifying Your Citations List” on page 24.

Figure 3-3. WestCheck 4.5 dialog box in the stand-alone application

CREATING A CITATIONS LIST FROM A DOCUMENT SAVED IN A DMS (STAND-ALONE APPLICATION)

Complete the following steps to create a citations list by extracting citations from a document saved in 
a document management system (DMS). You must have a DMS client installed on your computer.

1. At the Welcome dialog box, select Extract a citations list from a document in DMS, then click OK. 
If WestCheck is currently running, choose Extract From a DMS Document from the File menu.

2. WestCheck extracts the citations from your document. The extracted citations are displayed in the 
WestCheck 4.5 dialog box.

ADDING CITATIONS TO THE CITATIONS LIST

To add a citation to the WestCheck citations list, complete the following steps:

1. If you are using the integrated application, click the WestCheck button  on the toolbar, or 
choose WestCheck, Citations List from the Tools menu. In Word 2007, click the Add-Ins tab on the 

Select Create a new citations list, then click OK.

Double-click, 
type a 
citation, and 
press Enter.
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toolbar, click WestCheck on the Ribbon, and choose Citations List.

If you are using the stand-alone application, skip to step 2.

The WestCheck 4.5 dialog box is displayed.

2. Right-click anywhere in the Citation list box.

A pop-up menu is displayed (see Figure 3-4).

Figure 3-4. WestCheck 4.5 dialog box showing the Add a Citation option

3. Choose Add a Citation from the pop-up menu.

The cursor moves to the Double-click here to add a citation and then press Enter line at the end of 
the citations list.

4. Type the new citation on the line, then press Enter.

5. To add another citation, type it on the next Double-click here to add a citation and then press Enter 
line. Then press Enter.

MODIFYING A CITATION

You can edit a citation in the WestCheck citations list in the WestCheck 4.5 dialog box. To modify a 
citation, complete the following steps:

1. Double-click the citation you want to modify.

The citation is highlighted and a blinking cursor appears at the end of the citation.

2. Make your changes to the citation.

3. Press Enter to save your changes.

Note If you modify a citation in the citations list, WestCheck does not modify the original citation in 
your document.

DELETING A CITATION FROM THE CITATIONS LIST

Delete a citation from the WestCheck citations list in the WestCheck 4.5 dialog box by completing the 
following steps:

1. Right-click the citation you want to delete.

Choose Add a Citation to 
add a citation to the list.

Choose Delete Selected 
Citation to remove a citation 
from the list.
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A pop-menu is displayed (see Figure 3-4 on page 23).

2. Choose Delete Selected Citation from the pop-up menu.

A Delete Citation dialog box is displayed.

3. Select the Don’t ask me this again check box if you don’t want a confirmation before deleting a 
citation in the future.

4. Click OK to delete the citation.

LOCATING A CITATION IN YOUR DOCUMENT

You can quickly locate a citation in your document by selecting it within the citations list, right-clicking 
the citation, and choosing Locate Citation from the pop-up menu.

VIEWING CITATION PROPERTIES

To view the properties of a citation (e.g., parallel citations), select the citation in the citations list, right-
click the selected citation, and choose View Citation Properties from the pop-up menu.

Verifying Your Citations List
You can verify your citations list in WestCheck to determine if any case law citations in your list are 
inaccurate or incomplete. It is recommended that you verify your citations list before you run it in 
KeyCite or the document services so you can receive accurate and complete information. Verifying your 
citations can save you money because it can prevent charges for valid but incorrect citations, e.g., a 
citation for the wrong case that resulted from typographical errors.

Notes  

• WestCheck does not verify that your citations are in Bluebook format.

• WestCheck does not verify citations for statutes.

VERIFYING THE CITATIONS IN YOUR CITATIONS LIST

1. If you are using the integrated application, click the WestCheck button  on the toolbar, or 
choose WestCheck, Citations List from the Tools menu.  In Word 2007, click the Add-Ins tab on 
the toolbar, click WestCheck on the Ribbon, and choose Citations List.

If you are using the stand-alone application, skip to step 2.

The WestCheck 4.5 dialog box is displayed (see Figure 3-5 on page 25).
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Figure 3-5. WestCheck 4.5 dialog box showing the Verify Citations button

2. Click the Verify Citations button.

The Verify Citations dialog box is displayed (see Figure 3-6).

Figure 3-6. Verify Citations dialog box

3. Type your password in the Westlaw Password text box.

4. Type your client identifier in the Westlaw Client Identifier text box.

5. Choose the destination to which you want your verification result delivered from the Results 
Delivery drop-down list. If necessary, enter any additional information, e.g., download file name or 
e-mail address, in the appropriate text boxes.

6. Select the Remember Password check box to save your password so that the next time you access 
the dialog box, it will automatically be entered.

Note If you select the Remember Password check box, anyone logged in to the workstation with the 
same username will be able to use your password to sign on to Westlaw.

7. Click OK to verify your citations list. When WestCheck finishes verifying your citations list, an error 
report is sent to the delivery destination you chose.

Locating Inaccurate Citations in Your Citations List (in Word or the Stand-Alone Application)

After your citations list has been verified, a warning symbol is displayed at the end of citations that 
contain potential errors (see Figure 3-7 on page 26). The symbol will remain until the citation is 
corrected and the citations list is verified again.

Enter your Westlaw password and 
client identifier, then click OK.
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Figure 3-7. WestCheck 4.5 dialog box showing a citation with a potential error

To view the error message, complete the following steps:

1. Right-click the citation and choose Show Error Message from the pop-up menu.

A Citation Error Message dialog box is displayed, which explains the error.

2. After viewing the error message, click OK to close the Citation Error Message box.

Note You can also view the error message by viewing the verification result.

Conditions That Cause a Citation Error

Listed below are situations in which WestCheck displays the warning symbol and creates a warning 
symbol after a case law citation:

• The citation is not in a valid format (the citation is not in a format recognized in KeyCite or the 
document services).

• The Westlaw citation has been replaced by a different Westlaw citation.

• The publication is not valid in KeyCite or the document services.

• KeyCite is not available for the citation.

• Multiple documents were found with the citation.

• WestCheck did not find a document that begins on the page given in the citation.

• The results line limit has been exceeded.

• The title is missing or does not match the title on Westlaw.

• The parallel citations entered do not match the parallel citations on Westlaw.

If you see the 
warning 
symbol next to 
a citation, the 
citation 
contains a 
potential error.
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